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ค�ำน�ำ

หนังสือเล่มน้ีเป็นการน�ำเสนอเน้ือหาการเขียนโปรแกรมด้วยภาษา VB ส�ำหรับคุณผู้อ่าน 

ที่ต้องการศึกษาการเขียนโปรแกรม ในปัจจุบันการเขียนโปรแกรมถือเป็นสกิลติดตัวอีกด้านหน่ึง
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ซอฟท์ก�ำหนดให้รวม .NET Core เวอร์ชัน 3.x เข้ากับ .NET Framework เวอร์ชัน 4.x กลายเป็น 

.NET 5 เพียงหนึ่งเดียว หมายความว่า เนื้อหาที่คุณศึกษายังคงใช้งานได้ต่อไป

ส�ำหรับคุณผู้อ่านท่านใดที่ต้องการสอบถามปัญหา มีข้อเสนอแนะ หรือค�ำติติงข้อผิดพลาด

ต่างๆ สามารถติดต่อผู้เขียนได้ 4 ช่องทางคือ

1.	 แฟนเพจใน Facebook ที่ https://www.facebook.com/thaivb.net

2.	 กลุ่มใน Facebook ที่ https://www.facebook.com/groups/thaivb.net

3.	 ช่อง YouTube ที่ชื่อว่า : Thaivb.NET

4.	 แฟนเพจใน Blockdit ที่ https://www.blockdit.com/thaivb.net

ศุภชัย สมพานิช
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บทที่ 1 เตรียมความพร้อมก่อนเริ่มต้นเขียนโปรแกรมด้วยภาษา Visual Basic 2019 1

โลกของการเขียนโปรแกรมในยุคของ .NET ไม่ได้มีแต่เพียงแค่พัฒนาโปรแกรมบน PC  

เพียงอย่างเดียวเท่าน้ัน แต่ยังรวมไปถงึมือถอืและแทบ็เล็ตอกีด้วย ไมโครซอฟท์พัฒนา Visual Studio 

2019 (เรียกสั้นๆ ว่า VS 2019) ขึ้นมา เพื่อรองรับการพัฒนาโปรแกรม 3 ช่องทาง คือ

1.	 พัฒนาโปรแกรมส�ำหรับ PC (หรือ Notebook) อยู่ในความรับผิดชอบของโปรเจก็ต์ประเภท 

Windows Forms Application ผลลัพธ์ของโปรเจ็กต์ประเภทนี้ คือ ไฟล์นามสกุล .exe หรือ 

.msi ที่เราคุ้นเคยกันเป็นอย่างดี

2.	 พัฒนาโปรแกรมบนเว็บ (ไม่ข้ึนกับแพลตฟอร์ม) อยู่ในความรับผิดชอบของโปรเจ็กต์

ประเภท ASP.NET MVC

3.	 พัฒนาโปรแกรมส�ำหรับมือถอืและแทบ็เล็ต น่ันคอื Android/iOS Apps อยู่ในความรับผิดชอบ 

ของโปรเจ็กต์ประเภท Xamarin

ขอบเขตการน�ำเสนอของหนังสือเล่มนี้
เน้ือหาทีจ่ะน�ำเสนอในหนังสือเล่มน้ี ครอบคลุมการพัฒนาโปรแกรมบน Desktop, Web, มือถอื  

และแท็บเล็ต โดยอาศัยภาษา Visual Basic 2019 (เรียกสั้นๆ ว่า VB 2019) ในระดับเบื้องต้น

เท่าน้ัน แต่กมี็เน้ือหาสาระเพียงพอทีจ่ะต่อยอดในล�ำดับต่อไป ประกอบด้วยเน้ือหา 3 ส่วนใหญ่ๆ คอื

1.	 ศึกษาไวยากรณ์ภาษา VB และพัฒนาแอพส�ำหรับ Desktop โดยอาศัยโปรเจ็กต์ประเภท 

Windows Forms Application 

2.	 พัฒนาแอพท�ำงานกับระบบฐานข้อมูล SQL Server ด้วย Entity Framework เรียกสั้นๆ ว่า EF

3.	 พัฒนา Web Application ด้วย ASP.NET MVC และยังรวมไปถึงแนะน�ำการพัฒนา Web 

API ในโลกของ .NET

บทที่

01
เตรียมความพร้อมก่อนเริ่มต้นเขียนโปรแกรม
ด้วยภาษา Visual Basic 2019
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การดาวน์โหลดและตดิตัง้โปรแกรม Visual Studio 2019
การพัฒนาโปรแกรมในโลกของ .NET มีหลายวิธี หนังสือเล่มนี้อาศัยโปรแกรมที่ชื่อว่า Visual 

Studio 2019 โดยสามารถดาวน์โหลดมาใช้งานได้ฟรี มีขั้นตอนดังนี้

1.	 ไปที่เว็บไซต์ www.visualstudio.com เลือกดาวน์โหลดโปรแกรม Visual Studio 2019 

เวอร์ชัน Community Edition เวอร์ชัน Preview มาใช้งานได้ฟรี ดังรูปที่ 1-1

รูปที่ 1-1 แสดงการดาวน์โหลดตัวติดต้ังโปรแกรม Visual Studio 2019

2.	 ดับเบลิคลิกไฟล์ทีด่าวน์โหลดมา เพ่ือเข้าสู่ข้ันตอนการติดต้ังโปรแกรม Visual Studio 2019 

สามารถเลือกประเภทโปรเจ็กต์ที่คุณสนใจได้อย่างอิสระ โดยขอบเขตการน�ำเสนอเน้ือหา

ของหนังสือเล่มนี้ ประกอบด้วย

�	 ASP.NET and web development ส�ำหรับพัฒนาโปรเจ็กต์ประเภท Web Apps

�	 .NET desktop development ส�ำหรับพัฒนาโปรเจก็ต์ทีรั่นบนระบบปฏิบติัการ Windows

รูปที่ 1-2 แสดงหน้าจอเลือกติดต้ังประเภทโปรเจ็กต์

VB 2019.indb   2 24/8/2563 BE   15:14



บทที่ 1 เตรียมความพร้อมก่อนเริ่มต้นเขียนโปรแกรมด้วยภาษา Visual Basic 2019 3

3.	 ท้ายที่สุด ให้คุณรอการดาวน์โหลดและติดต้ังรายการต่างๆ ตามที่เลือกจนเสร็จสมบูรณ ์

ถือว่าโปรแกรม Visual Studio 2019 พร้อมใช้งานแล้ว ดังรูปที่ 1-3

รูปที่ 1-3 แสดงการติดต้ังโปรแกรม Visual Studio เสร็จสมบูรณ์

ท�ำความรู้จักกับประเภทโปรเจ็กต์ที่น่าสนใจในขั้นต้น
โปรแกรม Visual Studio รองรับการพัฒนาแอพในแพลตฟอร์มต่างๆ มากมาย แยกติดตั้ง 

แต่ละประเภทอย่างชัดเจน ที่น่าสนใจในขั้นต้นมีดังนี้

1.	 ASP.NET and web development การพัฒนา Web Apps หรือสร้างเว็บไซต์ในโลกของ 

.NET/.NET Core อยู่ในความรับผิดชอบของโปรเจ็กต์ประเภท ASP.NET มีโปรเจ็กต์ที่น่า

สนใจ คือ ASP.NET Core MVC และ ASP.NET Core Web API
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2.	 Python development คุณสามารถเขียนโปรแกรมภาษาไพธอนได้ด้วยเช่นกัน

3.	 Azure development เป็นโปรเจก็ต์ทีร่องรับการใช้บริการต่างๆ บน Cloud ของไมโครซอฟท์  

เรียกว่า Azure

4.	 Node.js development เป็นแพลตฟอร์มที่ใช้ส�ำหรับสร้าง Web Apps หรือสร้างเว็บไซต์โดย

อาศัยภาษา JavaScript ทั้งฝั่ง Client และฝั่ง Server เพียงภาษาเดียว เรียกว่า MEAN Stack

5.	 .NET desktop development เป็นโปรเจ็กต์ที่ใช้สร้างแอพที่ติดต้ังบน Windows ที่เรา 

คุน้เคยกนัเป็นอย่างดี คอื ไฟล์นามสกลุ .exe หรือ .msi โดยอาศยัภาษา VB หรือ C# น่ันเอง

6.	 Universal Windows Platform development เป็นโปรเจ็กต์ที่ใช้ส�ำหรับสร้างแอพที่ติดตั้ง

บน Windows 10 

7.	 Desktop development with C++ เป็นโปรเจ็กต์ที่ใช้สร้างแอพที่ติดต้ังบน Windows  

เช่นกัน แต่ใช้ภาษา C++

8.	 Mobile development with .NET การพัฒนา Mobile Apps ในโลกของ .NET เป็นหน้าที่

ของโปรเจ็กต์ที่เรียกว่า Xamarin สามารถพัฒนาได้ทั้ง iOS/Android Apps

การอัพเดตโปรแกรม Visual Studio 2019
ในปัจจุบันไมโครซอฟท์มักจะมีการอัพเดตโปรแกรม Visual Studio อยู่เสมอ เพ่ืออัพเดต

ฟีเจอร์ใหม่ต่างๆ และยังรวมไปถึงการแก้ไขข้อผิดพลาดต่างๆ ที่เกิดขึ้นอีกด้วย โดยมีขั้นตอนดังนี้

1.	 ที่หน้าจอเริ่มต้น เลือก Create a new project > Install more tools and features เพื่อเข้าสู ่

ขั้นตอนการอัพเดตโปรแกรม Visual Studio ดังรูปที่ 1-4

เลือก 1.1
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รูปที่ 1-4 แสดงการเข้าสู่ขั้นตอนการอัพเดตโปรแกรม Visual Studio

2.	 คลิกปุ่ม  การอัพเดตโปรแกรม Visual Studio เป็นไปตามรายการที ่

คุณเลือกติดตั้งโดยอัตโนมัติทั้งหมด ดังรูป 1-5

รูปที่ 1-5 แสดงขั้นตอนเร่ิมต้นอัพเดต

เลือก1.2

เลือก2

VB 2019.indb   5 24/8/2563 BE   15:14



คู่มือ coding ด้วย Visual Basic 2019 ฉบับผู้เริ่มต้น6

Visual Basic 2019

3.	 ท้ายที่สดุ ให้คลิกที่ปุ่ม  เพือ่เริ่มต้นดาวน์โหลดและติดตั้งรายการอัพเดต

ต่างๆ ตามเวอร์ชันปัจจุบันของคุณ ซึ่งเป็นข้ันตอนอัตโนมัติทั้งหมด ให้รอจนเสร็จส้ิน  

ถือว่าจบขั้นตอนการอัพเดตโปรแกรม Visual Studio ดังรูปที่ 1-6

รูปที่ 1-6 แสดงการดาวน์โหลดและติดต้ังรายการอัพเดตโดยอัตโนมัติ

จากรูปที่ 1-6 คุณสามารถคลิกที่ลิงค์ Release notes เพ่ือตรวจสอบว่า อัพเดตปัจจุบันมี

รายการอะไรบ้าง

เลือก3
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การติดตั้งฟอนต์ Cascadia Code ส�ำหรับเขียนโค้ด
โดยเฉพาะ

ไมโครซอฟท์สร้างฟอนต์ส�ำหรับเขียนโค้ดโดยเฉพาะข้ึนมา ช่ือว่า Cascadia Code สามารถ

ดาวน์โหลดมาใช้งานได้ที่เว็บไซต์ https://github.com/microsoft/cascadia-code/releases  

ดังรูปที่ 1-7

รูปที่ 1-7 แสดงเว็บไซต์ที่ให้ดาวน์โหลดฟอนต์เขียนโค้ด

จากรูปที่ 1-7 ให้คุณ Copy ฟอนต์ที่ได้มาไปไว้ในพาธ C:\Windows\Fonts ก่อน จากนั้นเปิด

โปรแกรม Visual Studio ขึ้นมา เลือกเมนู Tools > Options ที่หัวข้อ Environment > Fonts and 

Colors เลือกใช้ฟอนต์ที่ชื่อว่า Cascadia Code

ข้อแตกต่างของฟอนต์ Cascadia Code กบัฟอนต์อืน่ๆ ทีน่่าสนใจ คอื สามารถแสดงสัญลักษณ์

พิเศษทางภาษาได้ เช่น เคร่ืองหมายหัวลูกศร เกิดมาจากการพิมพ์เคร่ืองหมาย = ติดกับเคร่ืองหมาย

มากกว่า > ดังรูปที่ 1-8
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รูปที่ 1-8 แสดงเคร่ืองหมายลูกศรในโค้ด

การสร้างโปรเจ็กต์ Windows Forms App (.NET 
Framework)

โปรเจ็กต์แบบ Windows Forms App (.NET Framework) ถือเป็นโปรเจ็กต์ที่เหมาะสมกับการ

เริ่มต้นเขียนโปรแกรมมากที่สุด มีโครงสร้างโปรเจ็กต์ค่อนข้างง่าย มีขั้นตอนดังนี้

1.	 ที่หน้าจอเริ่มต้น ให้คุณเลือก Create a new project จากนั้นเลือกสร้างโปรเจ็กต์ประเภท 

Windows Forms App (.NET Framework) ดังรูปที่ 1-9

รูปที่ 1-9 แสดงการสร้างโปรเจ็กต์ Windows Forms App (.NET Framework) ของภาษา VB

เลือก1.1

คลิก1.2
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2.	 เป็นการก�ำหนดรายละเอียดให้กับโปรเจ็กต์ที่จะสร้างขึ้นมา โดยที่

�	 ช่อง Project name หมายถึง ชื่อโปรเจ็กต์ ในกรณีนี้ตั้งชื่อว่า BasicApps

�	 ช่อง Location หมายถึง พาธที่ใช้จัดเก็บโปรเจ็กต์ปัจจุบัน โดยการคลิกที่ปุ่ม  เลือก

โฟลเดอร์ตามทีค่ณุต้องการ ในกรณีน้ีเก็บโปรเจก็ต์ไว้ทีพ่าธ E:\Projects ดังรูปที ่1-10

รูปที่ 1-10 แสดงการก�ำหนดรายละเอียดให้กับโปรเจ็กต์ที่จะสร้างขึ้นมา

รูปที่ 1-11 แสดงสภาพแวดล้อมของ VS 2019 แบบ Windows Forms Application

จากรูปที่ 1-11 รายละเอียดแต่ละหน้าต่าง มีดังนี้

�	 หมายเลข 1 แถบเครื่องมือส�ำหรับทดสอบโปรเจ็กต์ปัจจุบัน

�	 หมายเลข 2 แถบคอนโทรลส�ำเร็จรูป ท�ำหน้าทีอ่อกแบบส่วนแสดงผล (User Interface 

เรียกย่อๆ ว่า UI) ภายในโปรเจ็กต์ของคุณ

กรอกชื่อ2.1

คลิก2.2

คลิก2.3

1
4

5

3

2
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Visual Basic 2019

�	 หมายเลข 3 ส่วนแสดงผลจ�ำลอง คณุสามารถออกแบบส่วนแสดงผลให้กับหน้าจอต่างๆ 

ได้ที่นี่ โดยการลากคอนโทรลต่างๆ มาวาดตามที่ต้องการ

�	 หมายเลข 4 เรียกว่า หน้าต่าง Solution Explorer ท�ำหน้าที่แสดงโครงสร้างโปรเจ็กต์

ปัจจุบันของคุณว่าประกอบไปด้วยไฟล์อะไรบ้าง

�	 หมายเลข 5 เรียกว่า หน้าต่างคุณสมบัติ (Properties) ท�ำหน้าทีแ่สดงคณุสมบติัต่างๆ  

ของคอนโทรลที่ก�ำลังถูกโฟกัสในส่วนแสดงผลจ�ำลองว่ามีคุณสมบัติอะไรบ้าง โดย

สามารถแก้ไขคุณสมบัติต่างๆ ได้ตามที่ต้องการเช่นกัน เช่น ต้ังช่ือคอนโทรลได้ที่

คุณสมบัติ Name, ก�ำหนดสีพื้นหลังได้ที่คุณสมบัติ BackColor เป็นต้น

3.	 ให้คุณเลือกใช้คอนโทรล Label เข้ามาท�ำหน้าที่แสดงข้อความ “Hello VB” โดยการลาก & 

วางใน Form1 ซึ่งท�ำหน้าที่เป็นส่วนแสดงผล ดังรูปที่ 1-12

รูปที่ 1-12 แสดงการใช้งานคอนโทรล Label ใน Form1

ลากมาวาง3
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4.	 การก�ำหนดข้อความใน Label ตัวนี้ ให้แก้ไขคุณสมบัติ Text ได้ที่หน้าต่าง Properties ให้

เป็นข้อความตามที่คุณต้องการ

รูปที่ 1-13 แสดงการแก้ไขคุณสมบัติ Text ของคอนโทรล Label ตัวนี้

5.	 เป็นการก�ำหนดให้ Form1 ปรากฏอยู่กึ่งกลางหน้าจอและให้การโฟกัสที่ Form1 ก่อน 

โดยที่คุณสมบัติ StartPosition ท�ำหน้าที่ก�ำหนดต�ำแหน่งของ Form1 ผู้เขียนเลือกแบบ 

CenterScreen หมายถึง ให้ปรากฏขึ้นมากึ่งกลางหน้าจอ ดังรูปที่ 1-14

รูปที่ 1-14 แสดงการแก้ไขต�ำแหน่งของฟอร์มให้อยู่ก่ึงกลางหน้าจอ

จากรูปที่ 1-14 ณ จุดนี้ ได้โปรเจ็กต์ตามที่เราต้องการแล้ว

กรอกข้อมูล4

คลิก5.1

เลือก5.2
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Visual Basic 2019

การออกแบบส่วนแสดงผลด้วยคอนโทรล (User  
Interface)

ไม่ว่าคุณจะสร้างโปรเจ็กต์ประเภทใดก็ตามใน Visual Studio 2019 ไมโครซอฟท์ก�ำหนดให้

สภาพแวดล้อมของตัวโปรแกรม Visual Studio 2019 มีลักษณะคล้ายกัน ใกล้เคียงกันมากที่สุด 

เท่าที่จะเป็นไปได้ เพื่อให้นักพัฒนาคุ้นเคยกับตัวโปรแกรมได้ไม่ยาก

รูปที่ 1-15 แสดงแถบ Toolbox ของโปรเจ็กต์แบบ Windows Forms App (.NET Framework)

จากรูปที่ 1-15 แถบคอนโทรล (Control) อยู่ด้านซ้ายมือ ท�ำหน้าที่ออกแบบส่วนแสดงผล 

(User Interface เรียกย่อๆ ว่า UI) ในขั้นต้นนี้คุณสามารถใช้งานคอนโทรลนี้ได้ 2 วิธี
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บทที่ 1 เตรียมความพร้อมก่อนเริ่มต้นเขียนโปรแกรมด้วยภาษา Visual Basic 2019 13

1.	 ดับเบิลคลิกที่ตัวคอนโทรล เพ่ือก�ำหนดให้ Visual Studio ใช้งานคอนโทรลดังกล่าวใน 

หน้าจอออกแบบโดยอัตโนมัติ เช่น ผู้เขียนต้องการใช้ปุ่มกด Button1 ดังรูปที่ 1-16

รูปที่ 1-16 แสดงการใช้ปุ่มกดด้วยวิธีการดับเบิลคลิกในแถบ Toolbox

2.	 คลิกเลือกคอนโทรลที่ต้องการใช้งาน แล้วน�ำไปวาดในส่วนของฟอร์ม (Form) ดังรูปที่ 

1-17

รูปที่ 1-17 แสดงการใช้ปุ่มกด Button ด้วยวิธีวาด

จากรูปที่ 1-17 เราได้ส่วนแสดงผลง่ายๆ มาแล้ว 1 หน้าจอ มีปุ่มกด Button เพียง 1 ปุ่ม

ดับเบิลคลิก 1

ลากมาวาง2
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Visual Basic 2019

การปรับแต่งคอนโทรลขั้นต้นด้วยวิธีแก้ไขคุณสมบัติ 
(Property)

คอนโทรลต่างๆ ทีน่�ำมาใช้งานสามารถปรับแต่งหรือแก้ไขได้ในหน้าต่างคณุสมบติั (Properties)  

กล่าวคือ เมื่อคุณโฟกัสที่คอนโทรลตัวใดก็ตาม หน้าต่างคุณสมบัติจะเปลี่ยนไปโดยอัตโนมัติ

รูปที่ 1-18 แสดงรายการคุณสมบัติของปุ่มกด Button

จากรูปที่ 1-18 ส่วนแสดงผลปัจจุบันของผู้เขียนมีเพียง 1 ปุ่ม เม่ือถูกโฟกัสแล้ว หน้าต่าง

คุณสมบัติก็จะแสดงรายการคุณสมบัติต่างๆ ของคอนโทรล Button ให้เราโดยอัตโนมัติ 

รายการคุณสมบัติของคอนโทรล Button ที่น่าสนใจ แสดงดังตารางต่อไปนี้

คุณสมบัติ หน้าที่

Name ท�ำหน้าที่ตั้งชื่อให้กับตัวคอนโทรล ใช้ส�ำหรับอ้างอิงตอนเขียนโค้ด

Text ก�ำหนดข้อความที่จะแสดงในปุ่มกด

BackColor ก�ำหนดสีพื้นหลังให้กับปุ่มกด

ForeColor ก�ำหนดสีตัวอักษรที่อยู่ในปุ่มกด

คณุสมบัติใดก็ตามท่ีถกูแก้ไขจะแสดงด้วยตัวอกัษรตวัหนา ส่วนตวัอักษรปกต ิหมายถึง เป็นค่าเริม่ต้นทีโ่ปรแกรม 

Visual Studio ตั้งไว้ โดยที่คุณไม่จ�ำเป็นต้องไปแก้ไขให้ครบทุกคุณสมบัติ ให้แก้ไขเฉพาะเท่าที่จ�ำเป็น

Note
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บทที่ 1 เตรียมความพร้อมก่อนเริ่มต้นเขียนโปรแกรมด้วยภาษา Visual Basic 2019 15

ต่อมาผู้เขียนลองใช้คอนโทรล Label ซึ่งท�ำหน้าที่แสดงข้อความ เม่ือคอนโทรล Label ได้

รับโฟกัส พบว่าที่หน้าต่างคุณสมบัติก็จะแสดงรายการคุณสมบัติของคอนโทรล Label ให้เราโดย

อัตโนมัติ

รูปที่ 1-19 แสดงรายการคุณสมบัติของโทรล Label

รายการคุณสมบัติที่น่าสนใจ แสดงดังตารางต่อไปนี้

คุณสมบัติ หน้าที่

Name ท�ำหน้าที่ตั้งชื่อให้กับตัวคอนโทรล ใช้ส�ำหรับอ้างอิงตอนเขียนโค้ด

Text ก�ำหนดข้อความที่จะแสดงใน Label

BackColor ก�ำหนดสีพื้นหลังให้กับคอนโทรล Label

ForeColor ก�ำหนดสีตัวอักษรที่อยู่ในคอนโทรล Label

AutoSize ก�ำหนดขนาดของคอนโทรล Label มี 2 แบบ คือ
�	 True หมายถึง ก�ำหนดให้ Label มีขนาดเท่าที่ข้อความแสดงอยู่
�	 False หมายถึง คุณสามารถก�ำหนดขนาดของ Label ได้อย่างอิสระ

คอนโทรลแต่ละตัวก็จะมีรายการคุณสมบัติทั้งที่เหมือนกัน และต่างกันไปตามหน้าที่ของตัว

มันเอง
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การก�ำหนดเลขบรรทัด
ส่วนการก�ำหนดให้ VS 2019 แสดงหมายเลขก�ำกับโค้ดในแต่ละบรรทัดท�ำได้ดังนี้

1.	 คลิกที่เมนู Tool > Options… 

2.	 จะปรากฏหน้าต่าง Options ให้เลือกหัวข้อ Text Editor > All Languages เลือกตัวเลือก 

Line numbers ดังรูปที่ 1-20

รูปที่ 1-20 แสดงการก�ำหนดให้แสดงหมายเลขก�ำกับโค้ดแต่ละบรรทัด

เลือก1.2

เลือก2.2

คลิก 1.1

เลือก 2.1

คลิก 2.3
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บทที่ 1 เตรียมความพร้อมก่อนเริ่มต้นเขียนโปรแกรมด้วยภาษา Visual Basic 2019 17

การทดสอบโปรเจ็กต์
หลังจากที่คุณออกแบบและเขียนโค้ดแล้ว ก็จะเข้าสู่ข้ันตอนการทดสอบโปรเจ็กต์ว่ามีการ

ท�ำงานหรือมีผลการท�ำงานเป็นไปตามที่เราต้องการหรือไม่ โดยการคลิกที่ปุ่ม  เพื่อ 

เริ่มต้นทดสอบรันโปรเจ็กต์

รูปที่ 1-21 แสดงการเร่ิมทดสอบโปรเจ็กต์

ในกรณีที่คุณต้องการหยุดรันโปรเจ็กต์ปัจจุบัน ให้คุณคลิกที่ปุ่ม  ดังรูปที่ 1-22

รูปที่ 1-22 กรณีต้องการหยุดรันโปรเจ็กต์ปัจจุบัน

สรุปท้ายบท

เน้ือหาในบทน้ีเป็นเพียงข้ันตอนการเตรียมสภาพแวดล้อมให้เคร่ืองของคณุพร้อมใช้งานเท่าน้ัน 

เนื้อหาในบทต่อไปจะเข้าสู่โลกของการเขียนโปรแกรมอย่างแท้จริง

คลิก

คลิก
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บทที่ 2 พื้นฐานการท�ำงานกับโปรเจ็กต์ประเภท Windows Forms App (.NET Framework) 19

บทที่

02
พื้นฐานการท�ำงานกับโปรเจ็กต์ประเภท 
Windows Forms App (.NET Framework)

ฟอร์ม (Form) ท�ำหน้าที่เหมือนกับเป็นตัวบรรจุ (Container) คอนโทรลต่างๆ เพื่อสร้างส่วน

แสดงผลตามที่คุณออกแบบไว้ เนื้อหาในบทนี้เราจะมาดูกันว่ามีอะไรสนใจในขั้นต้นบ้าง

ท�ำความรู้จักกับฟอร์ม (Form)
เมื่อคุณสร้างโปรเจ็กต์แบบ Windows Forms Application ก็จะได้ฟอร์ม (Form) ที่มีชื่อว่า 

Form1 เป็นหน้าจอเร่ิมต้น เรามักจะก�ำหนดให้แบบฟอร์มอยู่กึง่กลางหน้าจอ (หรือกึง่กลางส่วนแสดง

ผลเสมอ) โดยการก�ำหนดคุณสมบัติ StartPosition เท่ากับ CenterScreen ดังรูปที่ 2-1

รูปที่ 2-1 แสดงรายการคุณสมบัติของฟอร์ม

จากรูปที่ 2-1 เม่ือคุณโฟกัสที่ Form1 หน้าต่างคุณสมบัติก็จะแสดงรายการคุณสมบัติของ 

Form1 เช่นกัน 
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คุณสมบัติของ Form ที่ส�ำคัญ
แสดงดังตารางต่อไปนี้

คุณสมบัติ หน้าที่

Name ท�ำหน้าที่ตั้งชื่อให้กับฟอร์ม ใช้ส�ำหรับอ้างอิงตอนเขียนโค้ด

Text ก�ำหนดข้อความที่จะแสดงในแถบ Title Bar

BackColor ก�ำหนดสีพื้นหลังให้กับฟอร์ม

ForeColor ก�ำหนดสีตัวอักษรที่อยู่ในฟอร์ม

FormBorderStyle ก�ำหนดรูปแบบเส้นขอบของฟอร์ม โดยที่
�	 None หมายถึง ไม่มีแถบไตเติลบาร์
�	 FixedSingle หมายถึง ปรับขนาดฟอร์มไม่ได้ แต่มีปุ่ม Minimize, Maximize และ

ปุ่ม Close
�	 Fixed3D หมายถึง ก�ำหนดให้มีเส้นขอบแบบ FixedSingle แต่มีแนวลึกด้วย
�	 FixedDialog หมายถงึ ก�ำหนดให้เป็นแบบ FixedSingle แต่ใช้ในรปูแบบไดอะล็อก

โต้ตอบกับผู้ใช้งาน
�	 Sizable หมายถึง แบบฟอร์มปรับขนาดได้
�	 FixedToolWindow หมายถึง แบบฟอร์มปรับขนาดไม่ได้ และไม่มีปุ่ม Minimize 

และปุ่ม Maximize
�	 SizableToolWindow หมายถึง แบบฟอร์มปรับขนาดได้ และไม่มีปุ่ม Minimize 

และปุ่ม Maximize

MaximizeBox ก�ำหนดให้แบบฟอร์มแสดงปุ่มขยายขนาดฟอร์ม โดยที่
�	 True หมายถึง ให้มีปุ่ม Maximize มุมขวา-บน
�	 False หมายถึง ซ่อนปุ่ม Maximize 

MinimizeBox ก�ำหนดให้แบบฟอร์มแสดงปุ่มย่อฟอร์ม โดยที่
�	 True หมายถึง ให้มีปุ่ม Minimize มุมขวา-บน
�	 False หมายถึง ซ่อนปุ่ม Minimize 

IsMdiContainer ก�ำหนดให้ฟอร์มท�ำหน้าที่บรรจุฟอร์มอื่นๆ แบบหลายหน้าต่างได้หรือไม่ โดยที่
�	 True หมายถึง ก�ำหนดให้ฟอร์มเป็นตัวบรรจุแบบ MDI
�	 False หมายถึง ก�ำหนดให้เป็นแบบฟอร์มปกติ

WindowState ก�ำหนดขนาดของฟอร์ม โดยที่
�	 Normal หมายถึง ก�ำหนดให้ฟอร์มมีขนาดตามที่เราออกแบบ
�	 Minimized หมายถึง ก�ำหนดให้ฟอร์มมีขนาดย่อลงในแถบ Taskbar
�	 Maximized หมายถึง ก�ำหนดให้ฟอร์มมีขนาดเต็มหน้าจอส่วนแสดงผล
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การเพิ่มฟอร์มใหม่เข้ามาในโปรเจ็กต์
ในการพัฒนาแอพข้ึนมาใช้งาน ย่อมที่จะต้องประกอบไปด้วยส่วนแสดงผลต้ังแต่ 2 หน้าจอ 

ขึ้นไป ส่วนวิธีการเพิ่มหน้าจอใหม่เข้ามา ให้คุณคลิกเมนู Project > Add Windows Form… ในกรณีนี้

เราต้องการเพ่ิมหน้าจอใหม่ประเภท Windows Forms Application โดยต้ังช่ือว่า Form2 ดังรูปที ่2-2

รูปที่ 2-2 แสดงการเพ่ิมฟอร์มที่ช่ือว่า Form2 เข้ามาในโปรเจ็กต์

จากรูปที่ 2-2 ณ จุดนี้ โปรเจ็กต์ของเรามี 2 ฟอร์ม โดยปกติแล้วจะก�ำหนดให้ Form1 รันเป็น

ล�ำดับแรกเสมอ คณุสามารถแก้ไขได้โดยการคลิกขวาทีช่ื่อโปรเจก็ต์ เลือก Propreties ก�ำหนดทีช่่อง  

Startup form: ดังรูปที่ 2-3

คลิก 5

ฟอร์มที่ได้6

กรอกชื่อ4

เลือก3

เลือก2

เลือก1

VB 2019.indb   21 24/8/2563 BE   15:14



22

Visual Basic 2019

คู่มือ coding ด้วย Visual Basic 2019 ฉบับผู้เริ่มต้น

        
รูปที่ 2-3 แสดงการก�ำหนดให้ Form2 ปรากฏขึ้นมาเป็นล�ำดับแรก

วิธีการสั่งให้เปิดฟอร์มใหม่โดยการเขียนโค้ด
ส�ำหรับวิธีการสั่งให้เปิดฟอร์มใหม่ที่เราเพิ่มเข้ามามีขั้นตอนดังนี้

1.	 ใน Form1 ให้คุณดับเบิลคลิกที่ปุ่มกด Button1 เพื่อสร้างเหตุการณ์ Click() จากนั้นเขียน

โค้ดดังต่อไปนี้

Form1.vb

Option Explicit On
Option Strict On

Public Class Form1
    Private Sub Button1_Click(sender As Object, e As EventArgs) Handles Button1.Click
        Dim frm As New Form2()
        frm.Show()
    End Sub
End Class

เลือก 1 เลือก2
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การท�ำงานของโค้ดข้างต้นกค็อื ในเหตุการณ์ Click() ของปุม่กด Button ทีช่ื่อว่า Button1 ให้ท�ำ

�	 สร้างตัวแปรออบเจ็กต์ Form2 ที่ชื่อว่า Dim frm As New Form2() ขึ้นมาก่อน

�	 สั่งให้ Form2 ปรากฏขึ้นมา ผ่านทางตัวแปร frm ร่วมกับเมธอด Show() (frm.Show())

รูปที่ 2-4 แสดงโค้ดที่ใช้ส�ำหรับเปิด Form2

2.	 ทดสอบรันโปรเจ็กต์ พบว่าเราสามารถเปิด Form2 ได้แล้ว ดังรูปที่ 2-5

รูปที่ 2-5 Form2 ที่ถูกเปิดจากปุ่มกด Button1 ใน Form1

คลิก
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หลกัการเขยีนโปรแกรมแบบ Event Driven Programming
หลักการท�ำงานของภาษา VB เรียกว่า การเขียนโปรแกรมตอบสนองเหตุการณ์ที่เกิดขึ้น 

(Event Driven Programming) กล่าวคือ คุณเป็นผู้ก�ำหนดเองว่า เมื่อเกิดเหตุการณ์ Click() ให้

ท�ำอะไร, เมื่อเกิดเหตุการณ์ Load() ให้ท�ำอะไร เป็นต้น

หมายความว่า แท้ที่จริงแล้วการกระท�ำต่างๆ ที่ผู้ใช้งานกระท�ำต่อโปรแกรมของคุณ คุณ

เป็นผู้ก�ำหนดขึ้นมาเองทั้งสิ้นว่า “ให้ท�ำอะไร” ประเด็นที่ตามมาก็คือ วิธีการสร้างเหตุการณ์ให้กับ

คอนโทรลแต่ละตัวท�ำอย่างไร 

สมมติว่า ผู้เขียนต้องการสร้างเหตุการณ์ Click() ให้กับปุ่มกด Button ให้คุณลากปุ่มกด 

Button มาวางใน Form1 ดังรูปที่ 2-6

รูปที่ 2-6 แสดงการใช้งานคอนโทรล Button ใน Form1

การสร้างเหตุการณ์ให้กับปุ่มกด Button1 นี้ มี 2 วิธี คือ

1.	 ดับเบิลคลิกที่คอนโทรล Button1 เพ่ือส่ังให้ VS 2019 สร้างเหตุการณ์ประจ�ำตัวของ

คอนโทรล Button ขึ้นมา คอนโทรล Button ถูกสร้างขึ้นมาเพื่อท�ำหน้าที่รองรับการคลิก

จากผู้ใช้งาน ดังนั้น เหตุการณ์ประจ�ำตัวของคอนโทรล Button ก็คือ เหตุการณ์ Click()

 

รูปที่ 2-7 แสดงการสร้างเหตุการณ์ Click() ด้วยวิธีดับเบิลคลิก

ลากมาวาง

ดับเบิลคลิก1.1

เหตุการณ์ Click() 1.2
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แต่ละคอนโทรลมีเหตุการณ์ประจ�ำตัวแตกต่างกัน ขึ้นอยู่กับว่าคอนโทรลตัวนั้นๆ ถูกสร้างขึ้น

มาเพื่อ “ท�ำหน้าที่อะไร”

2.	 การสร้างเหตุการณ์อีกวิธีหนึ่ง คือ ให้คุณโฟกัสที่คอนโทรล Button1 ก่อน จากนั้นคลิกที่

ปุ่ม  ในหน้าต่าง Properties เพ่ือเลือกสร้างเหตุการณ์ที่เราต้องการ จะเห็นได้ว่าปุ่มกด 

Button รองรับหลายเหตุการณ์ ให้คุณดับเบิลคลิกที่ Click เพื่อสร้างเหตุการณ์ Click() 

ขึ้นมาส�ำหรับปุ่มกด Button1 ปุ่มนี้

รูปที่ 2-8 แสดงเหตุการณ์ Click() ที่ได้จากวิธีเลือกสร้างเหตุการณ์

ผู้เขียนลองต้ังโจทย์ง่ายๆ ว่า ต้องการแสดงข้อความ “Hello VB” เม่ือผู้ใช้งานคลิกที่ปุ่ม  

Button1 ดังโค้ดต่อไปนี้

Form1.vb

Option Explicit On
Option Strict On

Public Class Form1
    Private Sub Button1_Click(sender As Object, e As EventArgs) Handles Button1.Click
        MessageBox.Show(“Hello VB”, “ค�ำทักทาย”)
    End Sub
End Class

จากโค้ดข้างต้น เป็นการส่ังให้แสดงข้อความ “Hello VB” โดยอาศัยคลาส MessageBox  

เข้ามาท�ำหน้าที่สร้างไดอะล็อกแสดงข้อความ ดังรูปที่ 2-9

ดับเบิลคลิก2.3

คลิก2.2
เลือก 2.1
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รูปที่ 2-9 แสดงข้อความที่ได้

3.	 ในกรณีที่ดับเบิลคลิกบริเวณพ้ืนที่ว่างๆ ของ Form1 ส่งผลให้ VB สร้างเหตุการณ์ Load() 

ขึ้นมาให ้เหตุการณ์ประจ�ำตัวของ Form ก็คือ เหตุการณ์ Load() เพื่อให้คุณก�ำหนดว่า 

เมื่อ Form1 ถูกโหลดขึ้นมาแล้วให้ท�ำอะไร

รูปที่ 2-10 แสดงที่จัดเก็บโค้ดภาษา VB

พื้นฐานการใช้ฟอร์มแบบ MDI และสร้างระบบเมนู 
(Menu)	

ฟอร์ม (Form) ท�ำหน้าทีเ่ป็นตัวบรรจ ุ(Container) คอนโทรลต่างๆ ทีค่ณุเรียกใช้งานอยู่ โดยที่

ในแอพพลิเคชันชนิด Windows Application 1 ตัว จะต้องประกอบไปด้วยฟอร์มอย่างน้อยที่สุด 

1 ฟอร์ม เพื่อท�ำหน้าที่เป็นส่วนแสดงผลให้กับผู้ใช้ (เรียกว่า User Interface-UI) รูปร่างหน้าตา

โปรแกรมของคุณจะเป็นอย่างไร ก็จะขึ้นอยู่กับการออกแบบฟอร์มของคุณนั่นเอง 

เราสามารถแบ่งลักษณะของฟอร์มได้ 2 ลักษณะ คือ

�	 การใช้งานฟอร์มแบบ SDI (Single Document Interfaces) หมายถึง แอพพลิเคชันที่

สามารถเปิดเอกสารได้เพียงครั้งละ 1 เอกสาร หรือแสดงผลส่วนติดต่อกับผู้ใช้ได้ครั้งละ 

1 หน้าจอ 
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�	 การใช้งานฟอร์มแบบ MDI (Multiple Document Interfaces) หมายถึง การใช้งาน

ฟอร์มที่สามารถแสดงส่วนแสดงผล หรือส่วนติดต่อกับผู้ใช้ได้มากกว่า 1 หน้าจอในเวลา

เดียวกัน โดยที่จะมี 1 ฟอร์มท�ำหน้าที่เป็นฟอร์มแม่ เรียกว่า Parent Form ท�ำหน้าที่บรรจุ

ฟอร์มลูก ที่เรียกว่า Child Form 

 ตัวอย่างที่ 2-1  พื้นฐานการใช้งานฟอร์มแบบ MDI มีขั้นตอนดังน้ี

1.	 สร้างโปรเจ็กต์ที่ชื่อว่า UsingMDIForms โดยเปลี่ยนชื่อฟอร์ม Form1 เป็น frmMain ก่อน 

ดังรูปที่ 2-11

                 
รูปที่ 2-11 แสดงการเปล่ียนช่ือฟอร์มเป็น frmMain

2.	 ก�ำหนดให้ฟอร์มน้ีเป็นฟอร์มหลัก MDI ท�ำหน้าที่บรรจุฟอร์มลูกต่างๆ โดยการก�ำหนดที่

คุณสมบัติ IsMdiContainer = True ดังรูปที่ 2-12

รูปที่ 2-12 แสดงการก�ำหนดให้ฟอร์มนี้ท�ำหน้าที่เป็นฟอร์มหลัก MDI

คลิกขวา1.1

เลือก2

แก้ไขชื่อ1.3เลือก 1.2
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3.	 ให้คุณเลือกเมนู Project > Add Windows Form… เพื่อเพิ่มฟอร์มใหม่เข้ามาในโปรเจ็กต์ 

และตั้งชื่อว่า frmChild ท�ำหน้าที่เป็นฟอร์มลูก ดังรูปที่ 2-13

รูปที่ 2-13 แสดงฟอร์มลูกที่ถูกเพิ่มเข้ามาในโปรเจ็กต์

การสร้างเมนูให้กับฟอร์มหลัก 
หัวข้อนี้จะเป็นการสร้างเมนูเพื่อท�ำหน้าที่เรียกฟอร์มลูก โดยมีขั้นตอนดังนี้

1.	 ที่ฟอร์ม frmMain ต้องการสร้างเมนูในโปรแกรมของเราประกอบด้วย

�	 เมนู File เป็นเมนูหลัก

�	 เมนู ฟอร์มลูก… ท�ำหน้าที่เปิดฟอร์มลูก

เลือก3.1

คลิก 3.5

เลือก3.2

เลือก3.3

กรอกชื่อ3.4

ได้ฟอร์มลูก3.6

แสดงเมนูหลัก1.3
เลือก 1.1

เลือก 1.2
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รูปที่ 2-14 แสดงการสร้างระบบเมนูในแบบฟอร์ม frmMain

2.	 ที่ฟอร์ม frmMain ให้คุณเขียนโค้ดดังต่อไปนี้

โค้ด VB 2019 ที่ 2-1 พื้นฐานการใช้ฟอร์มแบบ MDI (frmMain.vb)

Option Explicit On
Option Strict On

Public Class frmMain
    Private Sub mnuFileOpenChild_Click(sender As Object, e As EventArgs) Handles mnuFile
OpenChild.Click
        Dim f = New frmChild()
        f.MdiParent = Me
        f.Show()
    End Sub
End Class

กรอกข้อมูล 1.4

เลือก 1.5

กรอกชื่อ1.6
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3.	 ท้ายที่สุด ให้คุณลองรันโปรเจ็กต์ พบว่าเมนูฟอร์มลูก... ท�ำหน้าที่เปิดฟอร์มลูก frmChild 

ขึ้นมา อยู่ในฟอร์ม frmMain ดังรูปที่ 2-15

รูปที่ 2-15 ผลการรันตัวอย่างที่ 2-1

อธิบายการท�ำงานของโค้ด

การเปิดฟอร์มลูกที่ช่ือว่า frmChild อยู่ในเหตุการณ์ mnuFileOpenChild_Click() โดยการ

สร้างตัวแปรออบเจ็กต์ฟอร์ม frmChild ที่ชื่อว่า f โดยที่

�	 ก�ำหนดชื่อฟอร์มแม่ได้ที่คุณสมบัติ MdiParent การเรียกชื่อแทนฟอร์มแม่ frmMain โดย

ใช้ค�ำสั่ง Me

�	 สั่งให้แสดงฟอร์มลูกโดยอาศัยเมธอด Show()

frmMain.vb

    Private Sub mnuFileOpenChild_Click(sender As Object, e As EventArgs) Handles mnuFile
OpenChild.Click
        Dim f = New frmChild()
        f.MdiParent = Me
        f.Show()
    End Sub

แสดงผล3.2
เลือก 3.1
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การลดขนาดโปรเจ็กต์ของ VB 2019
ไฟล์โปรเจก็ต์ทีไ่ด้มาจากโปรแกรม Visual Studio มีขนาดค่อนข้างใหญ่มาก โดยเฉพาะอย่างย่ิง 

ในกรณีที่มีการใช้งาน Package ต่างๆ เพิ่มเติม ดังรูปที่ 2-16

รูปที่ 2-16 แสดงขนาดโฟลเดอร์ที่จัดเก็บโปรเจ็กต์ VB 2019 เพียงโปรเจ็กต์เดียว

ในกรณีทีค่ณุมีโปรเจก็ต์จ�ำนวนมาก ย่อมทีจ่ะต้องใช้พ้ืนทีใ่นการจดัเกบ็มากเป็นเงาตามตัว คณุ

สามารถลดขนาดโปรเจ็กต์ลงได้ด้วย โดยมีขั้นตอนดังนี้

1.	 ให้คณุเข้าไปในโฟลเดอร์โปรเจก็ต์ของคณุก่อน จากน้ันลบโฟลเดอร์ .vs ออกได้เลย ดังรูปที่  

2-17

รูปที่ 2-17 แสดงการลบโฟลเดอร์ .vs

ลบโฟลเดอร์นี้ออก
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2.	 ในกรณีที่โปรเจ็กต์ของคุณมีการใช้งาน Package อื่นๆ เพ่ิมเติม ก็จะมีโฟลเดอร์ที่ช่ือว่า 

Package เพ่ิมเติมข้ึนมา ให้คณุเข้าไปในโฟลเดอร์น้ี จากน้ันลบรายการไฟล์ต่างๆ ออกเช่นกนั  

ดังรูปที่ 2-18

รูปที่ 2-18 แสดงการลบรายการ Package เพิ่มเติมต่างๆ

3.	 ให้คุณเข้าไปในโฟลเดอร์โปรเจ็กต์อีก 1 ระดับ จากน้ันลบโฟลเดอร์ bin และ obj ออก  

ดังรูปที่ 2-19

รูปที่ 2-19 แสดงการลบโฟลเดอร์ bin และโฟลเดอร์ obj

ลบรายการที่อยู่ 
ในโฟลเดอร์นี้ทั้งหมด

ลบ 2 โฟลเดอร์นี้ 
ออกทั้งหมด
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